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1. Introduction & Licensing
1.1 Introduction to DRASIimuCAD

Robotic Simulation Platform DRASIimuCAD is a software platform with CAD/CAM design
capabilities for workstation design & robot simulation, which supports user to perform 3D/2D
design, modelling, robot programming, Jogging, point teaching, RL editing, automatic path
generation as well as project management.

DRASIimuCAD is a PC application for CAD/CAM modeling, offline programming (OLP), and
simulation of robotic cells that allows user to work with an off-line controller, Virtual Robot
Controller (VRC) running locally on user PC for controlling the robot, allowing users to
perform robot and workstation simulation. This user manual is common for DRS / DRV series
of Delta Industrial robot.

DRASImuCAD = XIhAE
Virtual Robot
——  Simulation
: = - CAM CAD
AT

DRASIimuCAD benefits user to simulate the actual workflow in 3D environment to visualize
estimate and evaluate the Robot motion, analyze limitations like collision detection,
reachability. DRASIimuCAD reduces the teaching time through automatic path generation
CAM capability that will bring down the installation and commissioning time and improves
efficiency of robot automation.

Maijor features of DRASIimuCAD

+  Virtual Robot Simulation

+  CAD(Computer Aided Design): Creation , modification , analysis and optimization of 3D
design

+  CAM (Computer Aided Manufacturing): Integral tool for generation of path to improve

productivity and increase efficiency
3 A AELTA
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1.2 Software Installation & Licensing : New User

User should have administration privilege on the PC before installing DRASIimuCAD software.
DRASImuCAD offers the below installation options

*+ New User

»  Existing user

Note: For existing users to update to the latest release of DRASimuCAD, please refer
Software Installation & Licensing: Existing User Section 1.3 to uninstall, remove old files
and steps to install the updated release.

Below procedure is for software installation & Licensing of DRASIimuCAD for New User

Prerequisites for Software Installation: Hardware Specification

@ Hardware Spec:

BWindows System : Winl0 64bit
WIf the simulation is advanced its recommended for CPU i7, RAM 16G and discrete
graphics card .

CPU Minimum demand i5 2GHz or AMD same level CPU

Minimum demand 8GB
Minimum demand 5GB

Display card Display card compatible with DirectX, OpenGL

DRASIimuCAD software comes with two zipped files of Setup and user shall extract the first
folder (001), click DRASIimuCADSetup.exe file, and continue to install.

L] Common 28-10-20191653  File folder
Support 28-10-2019 16:53 File folder
%64 28-10-2019 16:53 File folder
zh-CN 28-10-2019 16:53 File folder
7h-TW 28-10-2019 16:53 File folder
D DRASImuCADSetup.config 14-08-2017 10:42 CONFIG File 1KB
DRASImuCADSetup 12-07-2018 18:35 Application 887 KB

4 A AELTA
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2018/8/14

=

i B The setup must update files or services that cannot be
W' updated while the system i running. If you choose to
continue, a reboot wil be required to complete the

b= setup.
|

:(
+(x86) - 120.3

L SW_TSE_2018... Delta Industrial Automation

DRf DRASImuCAD 2018

Microsoft Corporation

If the window shown above appears during installation, please click OK to continue

# DRASImuCAD_Addin
Select Installation Folder ==

The installer will install DRASImUCAD_Addin to the following folder.
To install in this folder, click “"Mext'". To install to a different folder, enter it below or click "Browse

Folder:
IC:\Della Industrial Automation\Deltad20 18D R A S imuC ADY I Browese. .
Disk Cost...

Install DRASImMuUCAD _Addin for yourself, or for anyone who uses this computer:

@ Everpone

O Just me

Cancel

Users shall follow the installation wizard stepwise
1. Inthe end of installation wizard, product activation screen pops up.
2. User needs to input the Serial number and code word provided by Delta Electronics, Inc.

in the corresponding box.

(& Registration - o X
Welcome to the DRASIMUCAD Actiation
SMUCAD Activate
Serial Number : | DRSWSCT1DA10T19500001
Code Word : | 5648-08894D38-3705
{Activate]

Activated License
¥/ IronCAD Path Generation

¥/ simulator Shoes

Information
Company : |pelta " Department : |RaABD
User Name : | ChrisTest | Comments : [ TWTC2PC0O154

UUID : [ 3656CC5006E11C3436B5D1BCE211670F

Result :
=

[Tron CAD Serial Number : IV TP2018-909271
‘lmn CAD Code Word : DE21 9422 B037 6338
C.

|CAD Class” Trisl
|Start Dot : 1211202010 120000 AM
Period 60

Simulator Authorization Key
54B0503E98335450406270E 38A2409CD9516F5BIFBCBADSEDS0C14FACO14E99EDS2ED

A AELTA
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3. Upon successful registration of product key, depending on the PC setting skip the
firewall alert in case required.
4. In case firewall alert pops up after the successful registration of the Product key,

skip the alert message.
5. Launch DRASImuUCAD and click New 3D Scene available on the top to enter the initial

screen of application

3D Scene

Open

pen Existing Document...

6. Open the License Manager tab available in the toolbar.

&

License
Manager

License Manager

7. User can cross verify the license registration with register date and expiration date. If

the data are OK, installation procedure is successfully completed.

[@)Activated Licenses - o %
Customer ID
Seral Number: | 0693D04B3E8C46C75651CCODACA4F894 Refresh
License Status
License Name RegisterDate Exp Date
PathGenerationApp 2020/04/29 Unlimited
ShoePadSprayingApp 2020/04/29 Unlimted
Simulator 2020/04/29 Unlimited

2020/6/12

6 A AELTA
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8. Shortcut to DRASIimuCAD desktop icon is generated automatically

g

1.3 Software Installation & Licensing : Existing User

DRASIimuC...
2018 (x64)

If user has to update the version with latest release of DRASimuCAD, the following would be

the recommended steps

1. Uninstall DRASIimuCAD from the control panel

VR Y
@Google (hrome
(ko ol Kehoad

Bineii v w i ie oA e

Delta lchonic, Inc,

GoogleLC
P

in

2. Locate DRASIimuCAD folder - Default Path (C:\Delta Industrial Automation\
DRASIimuCAD) in C: drive of the computer, manually delete the App Data, bin, and
Config folders. Translator Bundle folder cannot be deleted and hence shall be ignored.

AppData

bin

Config
Help
Images
Readme

TranslatorBundle

01-11-2019 1102
01-11-2019 11:04
01-11-2019 1102
01-11-2019 1102
01-11-2019 1103

01-11-2019 11:03

06-09-2019 0846

File folder
File folder
File folder
File folder
File folder
File folder

File folder

A AELTA
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Locate another DRASIimuCAD folder — Default Path C:drive - C: \ Users \ "user name" \

AppData \ Roaming \ Delta \DRASIimuCAD folder and delete the entire file .lts recomended
to switch ON “show hidden folders” options

| ﬂ = | DektaCatalog - O X
EE kil 7]
€ v 4« Deta » 2018 » DRASImUCAD » DeltaCatalog P

s : 268 *

# taEE B )

msE | DeltaCatalog 2018/2/22 ;= 0 2K8
_ %, DeltaRobot 2018/2/13 T 0. IRONCADCatalog 48704 KB

‘_ Ik fh DemoSample 2018/2/8 £509..  IRONCAD.Catalog 348 KB

Es A ToolCatalog W8/29 £5 1. RONCADCatelog 1,221 8

= ER

Note: In case if the above folder is not accessible, check in the option to show hidden folder
in View Tab.

Home  Share  View

. & bitralargeicons & Large icons sz Medium-sized icons Group by ¥ ¥/ ttem check boxes
[ Preview pane 2

&= Smallicons 2 List == Details 1 Add columns ¥ [ File name extensions
Navigation i . g= Sort ., .
nev oetspne £ e = Content v f Sizeall columns tofit V] Hidden items
pane by [ v
Panes Layout Current view Showhid

3. After completing Section 1.3 Step1 & 2 User to continue DRASImuCAD Software

Installation & Licensing New User Section 1.2 to install DRASimuCAD updated version.

Note: Any discrepancy in following and completing the above-mentioned procedure for
Software Installation & Licensing user requested to contact Delta Electronics Inc.

g A AELTA
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2. Basic Operation
2.1 Introduction to operating environment

2.1.1 User Interface (Ul)

B Startup view

Welcome X

FN,
N

SimuCAD SR Scene

Open H

. Open Existing Document...

Recent Documents

C:\Users\I-Erin.Chang\..\0710.ics

Note: Double cick to open recent documents

Description

Click New: Open New project
2. Click Open: Open the existing project

B Operating environment

JRizbon Bar Contextual Tabs
/

— \ 5
PeEmeas o i b iy
Podwre | Sekch Sufs | Acambly | Tk Vewkowe | Conewn | Amectaten  Addin | [owe @ ]-=»

\<> UTEvt-uJe 3 gt.cfl & @ &*D!_aftFuus E3: SD Emm G moveFace

S Bwon- Hivead lstetran . [ (T Enachrace T

Datum Berd Chandor Pattom : _
Pare~ G - @@Then | e Edoes (DlBookesn O Delete iody Fostira (4 Meror Footure = |+ 2 0F 5ol Foces
Rafarenc Feshsn Moty Transfoen Direct EAE

%,

“\Ribben Functional Area Groups
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B Quick Access Toolbar

The Quick Access toolbar provides a single location for quick access to common commands
or tools. For example, commands to start new scenes/drawings, open, save, undo/redo, and
the TriBall available in Quick Start toolbar. Users can customize this toolbar to add additional
common actions to match their design process.

B Operating Environment

2 4
e e
Description
Menu Menu
Virtual Robot Robot simulation
Feature 3D drawing
Sketch 2D drawing
Surface Drawing of curved surface
Assembly Assembly
Tools TriBall, dimensions, attachment points for Tool, positioning constraints
Common Default setting for Scene browser, catalog browser, Units etc.

1 A AELTA
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Toolbar: List of commonly used functions tabs
Scene browser : Hierarchical tree chart viewer of component in simulation window

Simulation screen window : Workspace for 3D modelling & robot simulation

A w0 Dp P

Catalog browser: Built-in library with Delta Robot, Demo Sample, Tool catalog, shapes
etc.
5. Status bar: Displays status information of view size, units, camera view, setting, tools

and related attributes.

B Main toolbar [Virtual Robot]

Icons on the main tool bar

Function Description
® To i i
= ggle button to enable and disable Simulator
’ ON/OFF ONJ/OFF

Simulator

DRVSOL7AG213 -

Select active Robot (Supports multiple robot

Robot selection with drop down menu)

Robot

B Proiect Manager Select project for the current robot and
P J 9 related Project management functions

Manager

.
RL Editor Edllt the. Robot Lgnguage for the selected

i project in the project manager.

@ Teach Function to Teach and edit point manager

Teach under selected project /robot

Displays the information pertaining to teach

Paints M i
© Point=Menager | Points Manager points coordinates , posture UF & TF data

ﬁ Jog Menu to jog the robot on the work space

09

e ,

e Alarm Reset Menu to reset the robot alarm if any

Reset

A )

cotns UF/TF Setting Menu to define the user frame and tool frame

setting

UF/TF

12 A AELTA
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1/0 Monitor

Monitor Input /Output status of the robot

Workspace Setting

Define work space limit of the robot —
Working / restricted area

Properties

Properties

Menu to define Properties & parameters of
the selected function under scene browser

Setting

Collision Detection

Collision Detection

Menu to set parameters of Collision detection

<

ShoePad
Spraying

Shoe Pad Spraying

Menu to configure application parameters for
the automatic path generation dedicated to
shoe pad spraying

=4

Path
Generation

Path Generation

Menu to configure application parameters for
the automatic path generation

A ) .
o CVT Setting Meny to configure Conveyor Tracking
Setting application parameters

i Qutput Output Window to view cycle time

|2} CreateObject

Create Object

Menu to configure User-defined simulation
components

\#i) LowQualityRender

Low Quality Render

Reduce screen resolution to optimize realistic
simulation speed

g‘:\

License

Menu to check the installed license
information

13 A AELTA
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2.2 Scene Browser

Hierarchical tree viewer of component in simulation window. Scene browser will group the
list of components in the simulation window with the parent component. All parts/ assemblies
used in the simulation window listed on the scene browser with a tree structure.

Multiple parts / assemblies as required by the user can be created on the scene browser.

Scenel* x
Scene AR UF: 0, TF: 0
Search . bl X:534,Y: 0, Z: 854
Yl RX: 0, RY: -90, RZ: -180

+) () Teached Points - 0710_RQEC.

w § gPBase
wQn
w$ 2
AR T
\—Sweisesces ___J
& Scene | @ Search (8] Properties

Note: If the welding torch is imported under the robot DRV70LA6213N then the scene
browser will show as below picture

Scene 2E
Search ... 17( A
N Scenel

J+ Global Coordinate Syster
=-S5 DRV70L7A6213N-379(VF
i T g7 Base

-5 1

-G J2

QI3

=g 14

3] &5 Cameras
- Lights

” A AELTA
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2.2.1 Catalog Browser

Catalog browser will list the inbuilt library of the Delta Robot models, tools catalog, demo
samples, shapes etc. To view complete built-in library functions click ¥ button in bottom right
corner to choose the appropriate function

} Hew |, Open | @ Sae [} Ciom

Note: Default path to access the built-in library is as below

»  Path to access built-in library of Delta Robot, Demo Sample, Tool Catalog

C:\Delta Industrial Automation\DRASimuCAD\AppData\en-us\Catalogs\Scene\DeltaCatalog
»  Path to access the built-in library of Shapes

C:\Delta Industrial Automation\DRASimuCAD\AppData\en-us\Catalogs\Scene\Metric

B Delta Robot

Built-in library of the Delta robot models of SCARA and vertical articulated robots. User can

choose the robot model as per the application requirement and generate a simulation to

check and confirm the robot suitability to the particular application.

»  Path - [Virtual Robot] - [Catalog Browser] - Delta Robot

+  Type: SCARA & Vertical Articulated robot (VA)

*  Operation: Choose the required robot in path Virtual robot - Catalog browser->Delta
Robot (SCARA / VA), left click continuously drag and drop the Robot to the Simulation
workspace.

15 A AELTA
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DRASImUCAD

0 Iniisl VRC Pavameter ?
am || '™

RSSOLESST  DRSGOL3SS.

Be e

DRS60LESS  DRSTOL6SST

DRV7OLTAS.

Note: A dialog box with “Initial VRC parameters?” will appear and user to choose the

options based on

the below definition.

“YES ”- Performs initialization of TF, UF, Workspace parameters.

(TF, UF and Workspace parameters reset to default values of Zero)

“NO - TF, UF, Workspace parameters will be retained without change

B Tool Catalog

Tools catalog has several reference tools, to mount on the robot for simulation. To attach

tool user needs to move the robot to Home position, drag and drop the required tool on the

Robot flange. After successful attachment of tool/gripper on the robot, user can locate the

tool/gripper under the robot tree in scene browser with Robot as the parent component.

* In built Library types: Welding Torch, Glue Gun, Mechanical Gripper

* Import Operation: Move robot to home position > Select Robot - Select Gripper tool
and press left mouse button continuously, drag the Gripper tool to the flange of Robot.
Tool will automatically attached to the robot flange end if the attachment point is

predefined. Flange will have a predefined attachment point EndP

Scene

Search ...

> DX ~  Catalog Browser

XA arch

W Scenel
©-J» Glof

- Table
=% DRVIOL7A6213N-18(VRC1)
w-§ &7 Base
= n
=9 2
= 13
=9 s
=R 5
=% J6
& @ WorkSpaces

- SEES

bal Coordinate System

v 3x

X

A AELTA



DIASimuCAD User Manual

B Demo Sample

For simulation and programming in DRASImuCAD, user shall utilize built in library models

of work pieces and equipment for standard simulation. Models of such standard equipment

libraries predefined in DRASImuCAD as demo sample. User defined work piece &

customized CAD models in neutral formats imported as geometries inside DRASImuCAD.

* Type: Feeder, Sensor, Table, Conveyor, Work Piece, etc.

»  Operation: Select Demo Sample, press the left button, drag, and drop to the simulation
screen.

DMV1000 DMV2000

B Shapes

Build-in catalog contains IntelliShapes with drag-and-drop solid modeling to provide the
easiest part/assembly design environment .User can custom design and develop the own
model, of tools / Grippers / Mechanism for simulation. Shapes will have built-in library for
quick use of widely used innovative parts.

+  Type: Block, H Block, Cylinder, etc.

»  Operation: Select Shape, press the left button, drag, and drop to the simulation

screen.

New [JL. Open | g/ Seve [ L Clom
Search . x
H Block Slab

vy &y
Slot H Slot
< o
H Cylinder Efipse
D4 g
Poly H Poly
<3 o
H Sphere Pie

17 A AELTA
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a. IntelliShape Shape Handles -Modify length, width, height etc.

H Block

w

Slot

vy ©

Cylinder  H Cylinder

Description

1. Leftclick on shape and drag to the simulation screen

2. Left click on the object twice

3. Drag the red handle to adjust the length, width and height of the object

b. Technique to align points, lines, and surfaces

Description

1. Left click on shape and drag to the simulation screen

2. Choose another shape part and drag & drop to the center point of a side as illustrated
above

3. Right click twice to choose the axis to align select the respective axis

4. Right click and select “Edge”

5. Select edge to align the part size

18 A AELTA
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2.2.2 TriBall operation

TriBall is a very effective and versatile multipurpose tool for positioning of components,
alignment of components, creation of new multiple components and editing of imported
models. TriBall is a used for panning, rotation and positioning of objects in the workspace

The TriBall translation controls consist of three handles and three planes on its surface that
allow user to move a part along or around any of its axes

Translation Confrols

'. 1D Handle
[~ et
'Hﬁ{: l "Jﬁ\ 20 Plane
N [
ANy — 3D Axis
i

1D (line movement)

Drag a 1D handle to move an object along an axis. As user drag, a distance value appears
beside the handle, indicating how far the object moved from its original location. User can
enter a distance value directly after dragging the handle or after the direct input field is
deselected user, can right-click the distance value, choose Edit Value from the resulting
pop-up menu, and enter the desired distance value in the dialog box.

2D (plane movement)

When user place the cursor inside a plane, the cursor displayed as four arrows, indicating
that the shape or part can be dragged up, down, left, or right along the 2D plane. As user
drag, a distance value for each direction in the plan will appear indicating how far the object
moved from its original location

3D (rotation)

When user click a 3D handle, its axis of rotation is selected and highlighted. To rotate an
object around the selected axis, move the cursor within the TriBall. When the cursor
changes to a hand and arrow, click and drag to rotate the object around the axis. As user
drag, the current angle of rotation displayed in degrees

19 A AELTA
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B Operation: Select the object; enable TriBall in Tools Tab or from the quick access
toolbar.
W Shortcut key : F10

ABGE S hrg s

Menu VirtualRobot Feature Sketch Surface Assembly
o %Eusitioning Constraints %:% OF Analysis =2 Check Clearance
Q—H ﬂ& Mate & Align Positioning £ 3. Statistics
TriBall Fixed in P Mechanism R
Ereed in Parent Mode (¥ Check Interference
Positioning Inspection

a. Panning and rotation

The external handles used for the pan and rotation.

+ Pan Operation: Enable TriBall > Drag a 1D handle to move an object along an axis.
User can directly pan on the workspace or input the distance in the window

* Rotation Operation: Click the 3D handle, axis of rotation selected and highlighted >
Drag the cursor to rotate around the selected axis.

20 I:XBEHZ
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b. Aligning and positioning

Internal handle used for alignment and positioning the object to the target position

B Operation: Click on the internal handle=> Right click on the internal handle = Select
option to align and position the selected part

*  Align Parallel to axes

Description

1. Click on the internal handle = Right-click select "Parallel to Axis"
2. Select the surface to be aligned with (axis)

3. Selected part will be aligned parallel to the surface

*  Aligning center points

Description

1. Click on the internal handle - Right-click select "To Center Point".

2. User can move the mouse to the target position system will automatically guide to the
center point of the chosen part

3. Selected part will get aligned to the center point

2 A AELTA
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c. Anchor adjustment

Every shape and part has an anchor composed of a green dot and two "whiskers" or short,
perpendicular lines. When a shape dropped into the scene as an independent part, a pushpin
also displayed at the anchor location. The anchor indicates the point where that shape or
part connects to others. For example, when user drop one shape on another one, the second
shape’s anchor lands on the surface of the first shape.

The two green "whiskers" on the anchor indicate the orientation of the object relative to the
global coordinate system of the 3D scene, as illustrated by the scene grid.

The object’s up direction
Indicated by the longer vertical green line. When user first drop a shape or part in the scene,
aligned to "up" direction with the height axis of the scene.

The object’s forward direction
The shorter, horizontal green line, points forward. Initially, the forward direction of an object
aligned with the length axis of the scene.

Operation: Using TriBall to move the anchor of object

Description

1. Select Part

2. Click start point on the pushpin of anchor

3. Press F10 to call out the TriBall function to move the anchor point
4. Choose target position to modify anchor location

2 A AELTA
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Description

1. Drag two tables independently into the simulation window.

2. Modify table anchor position: Click on the table, choose anchor and activate TriBall
- Right-click to select To Point to move the anchor to the corner of the desktop.~>Close
TriBall of anchor.

3. Modify table position: Select table = Press F10 to activate TriBall=>Pan directly to move
the table or right-click on the TriBall center point select To Point move to the corner of
another table.>Deactivate TriBall to complete table alignment operation

2 A AELTA
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2.2.3 Camera Setting

The camera represents your eye as you view the 3D scene. User can adjust the position of
the camera, the angle of its lens, and other features using the options on the Camera
properties. User can access the camera dialog by right-click in the scene and selecting
camera from the resulting menu

Projection
1. Perspective- Select this option to display objects in the scene in perspective.
2. Field of view angle. Enter the value in this field to view angle of the camera lens.

Panoramic Mode.

A typical camera will yield a realistic rendering of exactly what is visible in the DRASimuCAD
window. The Panoramic mode enabled to cause the rendering to show 360 degrees of the
scene. This is quite useful when generating 3D Environments.

B Zoom In, zoom Out, Pan, Rotate, Fit scene on the screen
Use the mouse and keyboard shortcuts to adjust the angle of view.

View Operation

Screen Pan Shift + middle button +Pan
Screen Rotation Press middle button and reorient
Focus Zoom Mouse wheel rotate back and forth
Fixed Zoom Ctrl + mouse middle button
Fit to view entire screen - o in the status bar

- Shortcut key F8

_ e,
Zoom view to fill rectangle in the status bar

- Ctrl+F5

B Camera Tools for Application window View

To alter view of the scene, use the camera tools. The user should note that the object shall
remain in the same position while the camera changes the view angle. User adjusting the
camera’s viewpoint and target point to view objects from different perspectives and angles

Shortcuts for the camera tools listed below
24 A AELTA
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e Shortcut : F7

Zoom Camera . Use the cursor to zoom the camera in or out.

Window Zoom (CTRL + [5:). Zoom view to fill rectangle.

Zoom to Zoom to the select rtffeature and center
camera.

Look At (F7). Set camera to look directly at a selected surface.

Target Camera (CTRL + F7). Shift center for camera orbit to the

selected shape.
Fit Scene (F8). Enlarge or shrink the view to fit the entire scens.
‘Save Camera.Save the camera configuration.

Custom Camera Manager. Manage previcusly saved camera
configurations.
Undo Camera. Undo the camera changes in the scene.

Redo Camera. Redo the camera changes that have been undone.
Perspective Camera (F9). Use the perspective camera.

Front. Orient the camera view to the front.

Top. Orient the camera view to the top.

Left. Orient the camera view to the left.

Right Orient the camera view tc the right.

Back. Orient the camera view to the back.

Bottom. Crient the camera view to the bottom.

‘op-front-left. Orient the camera view to the top-front-left. .
‘Top-front-right. Crient the camera view to the top-front-right. .
Bottom-front-left. Orient the camera view to the bottom-front-left. .
Bottom-front-right. Orient the camera view to the bottom-front-right. .

+|9| A|8p

o @@u alananes|e Blele

»
BACK
G BoTToM »

= E B.F‘R'e a;

Description

1. Import part to the scene window
2. In status bar choose camera view point icon and choose option
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2.2.4 Measurement Tools

The Measurement Tool allows user to take measurements between features on a part or
between parts in an assembly

Measurement types:

1.

© ®» N oG

Minimum Distance Dimension: Displays the minimum distance between two selected
items.

Linear Dimension: Measures the straight distance between 2 points or a point and a face.
Horizontal Linear Dimension: Measures the horizontal distance between two points
relative to the screen viewpoint.

Vertical Linear Dimension: Measures the vertical distance between two points relative to
the screen viewpoint.

Angular Dimension: Measures the angle between edges or faces.

Radial Dimension: Measures the radius of a circle or arc.

Diameter Dimension: Measures the diameter of a circle or arc.

Curve Measurement: Measures the total distance of a curve(s) or edge(s).

Face Measurement: Measures the area of a face or selected faces.

Operation: Toolbar [Tool] > [Dimension] - Choose appropriate tool

ACHE  Common

% Check Clearance ac: ;\, all[4 u

Operations |Dimension| Render Text  Animation

* E“Honzcntal v ‘_A i
) Oﬂad«al v -A
Smart o Measurement] Tet  Cosmetic
Dimension ﬁ_nguar Annotations Thread

Dimension

Length measurement

Measures the straight distance between two points or a point and a face
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Operation

R$ Check Clearance 3 ~ @ -

Operations Dimension Render

Text  Animation

[ Horizontal ~
© Badial - -

Measurement

Smant 1A angutar

=

et
Annotations

Cosmetic

Thread

Description

1.
2.

Click [Tool]-> [Dimension] - [Smart Dimension].
Select the edge to measure the length

B Angle Measurement

*  Operation
I I —
¥ Check Clearance aG - =1 - ]

Operations  Dimension Render

B Horizontal -
’KH‘ 3 Radial ~ =
NN v B

Description
1. Click [Tool]> [Dimension] > [Angular].
2. Select two edge to measure the angle between the two edges

27
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B Area Measurement

ARG Earg

o Ol BhcheckQemnce | [o5] N [@]|[4]( [m

~~ @5 Positioning Constraints.
%5 Mate & 2

Tigall A e Operations Dimension Render Tet Animation
= P g k rence 5 - e | = 5

Positioning Inspection
Scenel® x
Properties v ax
v X
e Dimension __
+ Measurement Tooks Measureent
HS B A [T, SRS

[ Hidden Direction Arrows
[ Hidden Previous Measurement
[ Using active coordinate
“ Angular Option
Measurement Mo... Actual v

*  Operation

Description

1. Click [Tool] - [Dimension] > [Measurement].

2. Click® (Face Measurement)

3. Click on the face to be measured - View result > Surface result (Highlighted)
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2.2.5 Hide Objects (Suppress)

If user looks to hide any part / assembly to have a better view on the simulation window,
hide option (Suppress) is available.

N Scenet
@-J+ Global Coordinate !
' omm

&) Cameras

% Lights

N Scenel
L Global Coordinate
g

&8 Cameras

% Lights

B Operation: Right Click on the object - [Suppress].
¢ Method 1: Toolbar [Tool] > [Operations] = [Suppress]

Common

halysis 2% Check Clearance 9 A, Q A B
atistics
Operations Dimension Render Text Animation

Inspection

> Q @ (@5 Combine Shapes 33 Group (X Reset Sizebox R Find i
9 102 EN to Inte [+ f) Section Part/Assembly [ Shape
h - ~
§up?r¢ss 3 -m Eegenenste R;i:;:;s (33 tt s Move Anchor (&) Attachment Point &
Opecstions

*  Method 2: Right-click on the object > [Suppress]

= Scene 8 Showw Selected
b e SloE - Show Selected and Sub Itern

S - d =]
==l
b= Ligh —3

Shell

Fixed imn Parent

=, Zoorm to Selection
e Browser
I == Suppress I
= .
~ Alloww Reordering

Prevent Scelection Bcelow Part
Find NoFace (Floating) Features
ldociate Linkcoac) ZD File

Note: To UN-suppress, the part user can select the object >Tools >Un-suppress part or in
scene 2>Right click=>again choose suppress option again
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2.2.6  Attachment Point

Even though objects are joined at their anchors, by default, they can be joined at alternate
locations by adding attachment points. Attachment points can be added anywhere on a
shape or part, then another shape can be attached directly to that point.

Delta robots will have predefined attachment points on the flange with name EndP. In case
user has to create a custom-made gripper, an attachment point of the same name needed
to be created to attach the gripper on the Robot flange.

B Operation: Select part >Tools = Attachment points

+  Add attachment point

When adding an attachment point, watch for the Z-axis orientation direction and use TriBall
to set the proper orientation to avoid mismatch of directional error.

2

nalysis 2% Check Clearance| L @ A "

atistics
Operations [Dimension Render Text Animation

Inspection

> o 2 @ Ij & ;omb.N  Reset Sizebox R Find in Scene Browser
> S \

a2 %= ff Section Part/Assembly [®] Shape Properties

Ghost B te Recreat
Sppress/; Siiost | Regensiste Display 00 ¢ Move Anchd] (4 Attachment Point

Description

1. Click a point on the part > Adjust the direction of the coordinates (Z-axis) for the
attachment point using TriBall.

2. Operations - Attachment Point
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+  Parameter setting for attachment point

Attachment Peint Name
Bltackenent Port Name
[EndP_MiConatan CoP Ca Ca2)

e ]
Type
[mEE O Mais M)

Recent used command

& Delete Attachment Point

1 =

Vasisble: [ Vi
v Lock J [V
Rened Vit 7]
Attach Triball
Vs |

[ A pasamaten expression ()

L Delete Modiy

Ofamse 1 Oossisd

Ve Or Expresson

Vahie only

A Comin ¥Ca)
[ Paalel P

[0 Coasis oY)
[)PasteiLY)

[IPaatelZIPLZ)

catalog_ent

Noke: 1 an sro i fourel, the tems vl be highighted i red to denots issus

Description

Right-click on the attachment point > Set Name
Set Tool attachment name as “EndP”

Select “Neutral” under Type.

Click OK to complete the setting.
Drag and drop the part to a new catalog
Select the robot and zoom in to flange position

© NGO ODN R

31

Check CoP (coincident), CoX (coaxis), and CoZ(coaxis) under Constraint.

New Catalog > Left click mouse >drag and drop part to the robot flange
The new tool attachment point will be attached to the robot predefined attachment point
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2.3 Robot Simulation

DRASIimuCAD control the Robot in the simulation screen through virtual controller VRC
running in the background. When user turns “ON” the Simulator function, robot will be active
to perform simulation. Robot will be updated with the current jogging position, teach position,
over travel limit, UF & TF data etc.

®  Switching robots
Methods to switch between robots when there are multiple robots

o %S R .
Teach Jog Setting

vo
andGo~ = Monitor
UF/TF  Monitor WorkSpace | Properties = Collision Detection License Manager  PathGeneration App ' Shoef]

a o

Setting  Properties

® < o § =4
DRVSOLTAG213N-5(VRCT)
Setting APP  Common License Setup

DRSE0LESS-311(VRC2)

¥ Scenel 2

3-8 DRVIOL7AE213N-S(VRC1)
® %@ DRSB0L6SS-311(VRC2)

& @ Comeras
¥ Lights

A Scene | @ Search (B Properties

Description

1. Method 1: Choose the robot from the drop down menu in Virtual robot >Robot
2. Method 2: Select the robot from the scene browser

3. Method 3: Select robot directly in the simulation screen.
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2.4 Jog & Alarm Reset

241 Jog

Functional menu to move the robot axis and choose parameters like speed, distance, and
mode (Cartesian or joint), active UF, TF, coordinate system etc.

B Operation

1 voouraena -

Description

1.

2.
3.
4

Turn “ON” the simulator button

Click on Robot

Click [Jog]

Jog page

Speed: Select the moving speed

Distance: Set the moving distance (inching/continuous)

Jog Mode: Joint mode / Cartesian mode

In Cartesian mode Home button: [y Robot returns to Home point

Note: Simulation button to be turned “ON” to activate robot related operation such as jog, go
to point etc. In case if the user is working on 3D modelling, positioning then Simulation button
to be turned “OFF”
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2.4.2 Alarm Reset

During robot jogging, moving beyond the working range of the arm, over travel alarm will
appear in the upper left corner. Robot movement is not possible when the alarm is active
and need reset to resume jogging. When the alarm appears, user can acknowledge the
current alarm with “alarm reset” button.

20, TF: 0 -
Es.ssx Y: -653.189, Z: 854.007 ols Y: -653.505, Z: 854.203

 BV- _on 7. _10n 90, RZ: -179.983

Description
1. Alarm appears in red font when robot is out of working range
2. Press [Alarm Reset] to acknowledge alarm.
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2.5 Project Management

Project Manager Menu support in creating a new Project and allows user to execute project
management functions like delete, rename and export project to target folders. User can
teach and save the points under the selected project.

B Add/Import projects

»  Operation

Description

1. Select Robot - Click Project Manager.

2. Click on the Robot type = Right-click to add a new project (Format within 26 English
characters)~> Select the project.

3. Open project.

4. The teach points of this particular project will get saved under the selected project

m  Export Project to MS
DRASIimuCAD support direct export of project to DRA Studio to execute the project with
actual robot. Upon completion of simulation user can save the project and close RL editor.
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m  Operation

oo

ROEOT!

| =8 > =8ER () > Dehaindustial Automation > DRASmUCAD » bin » VRC 3 VRCT | lua

Description

1.
2.
3.

DRASIimuCAD project

Project name location in Scene browser

Project path: Project is saved in default path "C:\Delta Industrial
Automation\DRASimuCAD\bin\VRC\VRC1\lua"

Project Folder Includes

RL program

Point information of teach points

UF, TF, Workspace information :File path "C:\Delta Industrial
Automation\DRASIimuCAD\bin\VRC\VRC1\VRC Parameter"

36
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2.6 Teach And Go

The Point manager displays information related to the teach point, such as coordinate name,
index posture, UF, TF ,coordinate information “X”,”Y”,”Z”,"RX",“RY”,”"RZ” and information
pertaining to posture .User to teach points initially and access points tab to use go to point
option during simulation .

®  Point Manager
Display the Point window to share information about the selected point.

*  Action: Click Points Manager.

Qg s 2@ m & & K L0 &

Teach Jog Alarm  Setting /O Setting  Properties Setting ShoePad  Path  CVT License
Reset Monitor Spraying Generation Seiting | 1 ORfende
Teach and Go Jog UF/TF | Monitor WaorkSpace | Properties | Collision Detection Common License Manager
v  Point v,
O nfo
: -368.228, Z: 174.626
\ Name: 1001 Index: 1001
- 0.42, RZ: 0
O coordinate
X 0.000 | Y: 0.000 | Z: 0.000

Rx: [ 0.000|RY: [ 0.000]Rz: [ 0.000
© Posture.

Ebow: 0 Shoulder: | 0 Fip: 0

2% Operator.

° Mo Mol

/I Show Name

Points Save GoTo

B Teach points
Teach will record the robot current coordinates values, posture with the active UF &TF details

Pounts Manager 5 g Boves
3 49 2@ 7 & o WL
oy Msm Setng VO  Seteg Propemes  Setmg St Pwh OV 2
Reset Monitee Spraying Genesstion Setting 1 Pe0utinde 2
G Jog  UBTE | Montor | WodSpace | Bropeies | Cotision Dtection 0 sove Mok Mgt
1. v bone vaofe v
e ploR2  hd 1002 & Sooed
L BETR
O Coormate.
o Dstance
x [ man)v [0z [ 1769%
inchog * Contrucus
wx | -190.000 [Rv: | 04201z [ 0000 § 3000 PUU
O Posture & Jog Made
Bow 0 Shoude: 0 Fo: 0 & Cotaen S
w0 ™0
oo
Cartesan Moce ™
w0 ™0
£ Operator o
- ow o .
o [ B
5 m e ﬁ
« >
« > | 3 Cotalog Browaer | Jog
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»  Operation

Description

1. Turn “ON” simulator

User can use jog option to move the robot to the target position

User shall click “Teach” to record the current point information

User can edit ,check/modify the selected point information

Select robot and Click Points Save to record the point inside the project.

a s wDn

B Go to point
“Go to” option in point window will help user to move the robot to the selected point position.

»  Operation

Description
1. Scene browser >Robot tree->Teach points-> Select point
2. Catalog browser->Point window-> click “Goto”

Note: User can check Show Name option to display the name of the point in the simulation
screen if necessary
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2.7 RL Editor( Robot Language Editor)

Set of Robot language instructions combined with motion command, Input/output
command and logic loops. Robot simulation sequence written using the set of RL
instruction and edited modified and controlled via Robot language editor.

(For details on Robot language Refer RL User Manual)

Type
Type Description
Motion Instruction on robot movement command
Parameter/ 10 Input and output instruction
Variable Instruction to edit point information
Logic Logical instructions

Operation

Open RL

Description

Select robot.

Click RL Edit.

“Always on top” icon will retain the RL editor window on top of the screen even when the
screen is switched
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RL editor screen

Ready

Description

File Manager

Program execution- Start , Stop , Pause and continue

Program editing

Click down arrow to check the RL code hidden

Comments are written by prefix “- -“symbol. User shall include the brief description of logic
and sequence for future reference.

Left click on the space next to line number ,will enable Breakpoints mark ( Circular red
mark) to pause RL program execution in the particular line number

Output window section displays the result after the program completes execution
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2.8 1/0 Monitor

1/0 Monitor menu will open a window, which will display all the 24 inputs and 12 outputs of
the Robot. User shall check the status of the input and output as well as control the output
of the robot using 10 monitor

B Operation

RX: 0, RY: 90, RZ: -180

fh Scene | € Search 8] Properties

/0 Monitor v B ox

Oumput 3 % output 9

|

Description

1.

2.
3.
4

Click on the toolbar Virtual Robot >1/0 Monitor

Click the corresponding Output to control the Output status to “ON”/"OFF”

Simulator to be turned “ON “ to control output of robot

Highlighted green indicates the output is “ON”, to switch “OFF” the output user needs to
toggle the same output once again.

If there is an input signal, the corresponding input will highlight with green.
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2.9 Properties

Property menu is multi-functional and action depends on corresponding selection in scene
browser. For configuration of I/O parameters properties tab will be active if at least one robot
is imported and selected in the scene browser. Properties is used to configure feeder,
conveyor, and sensor parameters. Corresponding features and parameters displayed when
properties tab chosen during the course of simulation.

®  Operation

B L Bl B

CVT ShoePad  Path License
Setting Spraying Generation
App Commeon License Manager

Input

Setting | Operation

[ Catalog Browses | Properties
5-&- 5 b o Any - [Defauk__ - [l

Units: mm. deg T, @ - O - W - & - @ &5~

View size: 827 x 525

Description

1. Select robot

2. Click Virtual Robot - Properties

3. Set parameters, I/0 connection - Click Set to complete the setting.
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2.9.1 I/O connection settings

Devices such as robot, gripper, feeder, sensor, and conveyor controlled and configured
through I/O settings

B Scenario

Robot used to control feeder to generate work piece on conveyor belt. Once the work piece
moves on the conveyor and intersects with the sensor beam an input is generated. Upon
reading the sensor input command, robot will move and grip the work piece.

W Scenario Setup in Simulation View

Description

Consider a scenario with choosing the DRV Delta Vertical articulated robot attached with
gripper tool, Feeder, conveyor, sensor. User to import, align and set parameters of the
individual components in the simulation window.

B |/O connection setting

Sensor Robot Gripper Feeder
DO1 DI1

DO1 DI1

DO?2 »DI1

a3 A AELTA
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B Setting up 10 connection between robot and sensor.

1.
2.

5.

Select robot >Properties

Click on in the Input field to set up Input connection
Propeties vB X InputLinkhodel Colecion Eitor Tox plinkoeCollecionEon ?
Members: Propertes Nenber: <lmets

v Connect Real Robot ' TEI Y G
Ip + i Vo
Port Input
Connect False W :::""""

v Robot 10 o
TR (cokcton) [
Ouput (Collction)

4 teme
o] o ® |

Click Add to link device member, Remove to remove the device.

Below setting of 10 Input 1 and From device Name “Sesnor-349” and output “1” will

generate robot input “1” if the sensor output becomes “1”

Can[el

Sensor Robot
OutputlinkModel Collection Editor ? QutputlinkModel Collection Editor ? X
Hembers: 1->Grioper-341(1) propettes: Hermbers: 2->Faeder453(1) propertes:
] | 4+ B3] (0] 1-+Gripper-341(1) + E3l4]
1| 2-»Feeder-453(1) 1
+ |v1l0 + v LI0
Qutput 1 Output 2
v 2.To Device v 2.To Device
Name Gripper-341 Name Feeder-453
Input 1 Input 1
Add Remove Add Remove

Click “OK” to save the settings.

44
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B Setting up IO connection between Gripper & Feeder with the Robot
1. Clickon I inthe Output field to set up for the Output connection.

Robot Gripper Robot Feeder
DO 1 - DIl DO2 ———DI1

Input

a
Output

nput

2. Click Add to link device member, Remove to remove the device.

3. Above setting of 10 input 1 and from device Name “Gripper-341”, input “1” will generate
gripper to close if robot DO1 switched “ON”.

4. Subsequent setting will generate the feeder to feed in component if robot digital output

2 triggered. | ERERR SBELL:

5. Click “OK” to confirm the setting.
6. Click “Set” to save the settings.
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2.9.2 Robot Real-time Synchronization

DRASImuCAD has the feature to display and update robot movement synchronized with the
actual robot running through MS. Robot movement will update real time with actual MS when
“Connect real robot” made “True” with the proper IP address & port number. Alarm status,
endpoint, user coordinate system, tool coordinate system, etc. synchronized and updated on
real time basis with the MS.

*  Operation

~ Connect Real Robot
I 192.168.1.1
Port 502
Connect True
Robot 1O
Input (Collection)
Output (Collection)
Connect
Change connect to real or virtual
Settng  Operation 5 4

I Set I
"l 3 Cotatog Browser sog | Properties

Description
1. Modify Connect to True > Set the IP and Port of the actual connected robot.
2. Click “Set”

n A AELTA
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2.9.3  Gripper

Virtual grippers used in simulating gripping and un-gripping operation with work pieces. To
install the gripper, click on the Robot, select the gripper from the built-in library under the
Tools Catalog window, drag and drop on the robot flange. (Refer Tool Catalog in Section
2.2.1).

®  Gripper I/O: Gripper IO setting

B Action: Click on Gripper - Properties

B Description of Properties settings:

Properties v 2 x [ inputtinkModel Collection Editor 3 ? x
“Members:
[~ Gripper 10 ) h _—
1 [ toew (Collection) B g [T 1< DRVSOL7A6Z1N-S25(VRC LIRS oml2! |
Output (Collection) + v 1.I0
| ~—&n ettin Input 2
5 I Distance 10 I Vv 2.From Device
Name DRV9OL7A6213N-3
Output 1 ~|

Distance
Unit(mm)

Setting Operation 6

Description

1. Click on the Input in Gripper IO to execute 10 setting
2. Add or remove I/O connected devices

3. Set the details of the I/0 connected devices

*  Set Input: Robot DO 1 connected with Gripper DI 1

Robot Gripper
DO1 DI1
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4. Click OK to confirm the setting.

5. Distance is the parameter between Gripper anchor and work piece anchor. Actual
distance in simulation shall be less than the distance setting to grip the component.
Below is the method to set the distance and anchor

*  Method 1: Adjust the Anchor position of the work piece.

*  Method 2: Adjust the Anchor position of the Tool endpoint.

6. Click “Set” to save the settings.
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2.9.4 Feeder

Feeder supports in generation of multiple work pieces. Feeder will automatically generate a
default feeder frame, which can be modified later using TriBall.

o ting
DI trigger is crested by DI

Feeder properties can define parameters of Feeder 10 control, feeding speed and quantity
of work pieces etc.

m  Feeder I/O: Input 1 group

B Operation: Click on Feeder > Properties

m  Description of Properties settings

Description
Click on Input Feeder 10 to do 10 setting.
Add or remove I/O-connected objects.
Set the details of the 1/0O-connected object.
Set Input: Robot DO 2 connected with Feeder DI 1
Click OK to confirm the setting.
Feeder Setting
a. File Name: Select CAD File Path. CAD File needs to be STP file.
b. Speed: The speed at which the work piece is generated (pcs/min)
c.  Number: An amount of n produced (n is an integer greater than or equal to
i.  Zero and “-1” means infinite count)
d. Mode:
i Normal: Auto generated >
Normal mode selected; the Feeder 10 (steps “1 ~ 4”) not necessary.
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12.
13.

14.
15.
16.
17.
18.

ii. DI trigger: Controlled by DI — Need to define step “ 1~4 *
Click “Set” to save the settings.
Turn on the Simulator - Click Operation
-> Click to switch between ON and OFF (ON->OFF to generate materials)
Feeder Frame is the point on the workspace where the work piece will generate.
Note: Scenario: Work piece generated by Feeder and moved directly on conveyor.
Practice: Check Feeder Frame on the conveyor setting
The location of the Feeder Frame is after conveyor PathFrameO.
Ensure the work piece generation position intersects with the conveyor path frame
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295 Conveyor

Conveyor

PathFramed N

Conveyor supports in moving the work piece on the defined conveyor path frame. In
simulation where user needs to move the work piece on a conveyor, built -in library function
of conveyor used to configure.

B Conveyor I/O: 2 sets of Input (Input 1: Start/Stop; Input 2: forward/backward)

m  Operation: Click Conveyor > Properties

Scene.

~| | 3.1TriBall - Move 3.2 TriBall - To Point
Search. ks

v Conveyor 10 X CA\Users\I-Erin.Chang)\Desktop!
@-J+ Global Coordinate System
- Table

5% DRVOOL7A6213N-18(VRC1),

~_Conveyor Setting ®

1 [ speed 0.05
Behavior Delete @ Sensor
Hode tormal & Feeder

Path Frame  Press Add Frame Butt}

7

— - = start point Framel :
Speed(m/s) end point
2 sepd operatin 5

B Description of Properties settings:
Description

1. Conveyor Setting

*  Speed: Speed of conveyor belt movement (m/s)
*  Behavior

a. STOP: Stop work piece after reaching the end point

b. Repeated Movement: Move back and forth between the starting and ending
points

c. Delete: Delete work piece after arriving at the end point
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® Mode
a. Normal: Automatic
b. DI Trigger, controlled by DI
- Need to set the [Input] in Conveyor IO (Similar to feeder setting steps 1-4). >
After turning on the Simulator->Operation of Conveyor to perform IO control for
the Input (Input 1: Start/ Stop; Input 2: forward/backward) control.

, 2% Input
Index State ON  OFF Content
1 ON OFF ON is start, OFF is stop
2 ON  OFF ON is forward, OFF is back

Setting Operation

1. Click Add Frame > Add PathFrameO (starting position) and PathFramel
(ending position).

2. Gotothe scene and select the newly added Path Frame. Use TriBall to move
the position of Path Frame.

3. Method of moving:
(3.1) Drag move to the target point.
(3.2) Quick align: Right click - to point->Target point

*  PathFrame0 Starting position; PathFramel: Ending position

»  Click “Set” to save the settings.

Note: Work piece generation frame needed to intersect with the conveyor frame so that the
work piece moves on the conveyor.
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2.9.6 Sensor

The sensor is a virtual element to trigger input when work piece intersects the sensor beam.
User to drag and drop sensor to the simulation view and configure sensor properties.

Sensor I/O: One set of Output

B Operation: Click on Sensor - Properties

B Description of Properties settings:

Properties v 2 x OutputLinkModel Collection Editor ? >
I+ sensor 10 Members: 2 3
1 ouwut (Collection) 5 |+ o5l 5 "
J Su2l | =
+ ~ 110
Output 1
v 2.To Device
Name DRVOOLZA6213N-1
Input
< >
add Remove
4o ]I cncer

Output
Can set one DO

Setting = Operation 5

Description

1. Click on Input in Sensor IO to execute IO setting.
2. Add or remove I/0O-connected objects.
3. Set the details of the I/O-connected object.

(3.1) Set Input: Sensor DO 1 connected with Robot DI 1

Sensor Robot
DO1 DI 1

4. Click “OK” to confirm the setting.
5. Click “Set” to save the settings.

Note: Input trigger when the work piece intersects with the sensor beam.

53
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2.10 UF/TF Definition

Menu to set the User Frame and Tool Frame for the Robot.
B Operation: Click on Robot - Setting (UF/TF)

0 Output
&£ Rl. B

Setting

Type: Orthogonal = Incined

Input Data

X(mm) Y (mm)  Z (mm)

> orginal o | o
+ Xaxis o o

XY o | o

Teach Set
&% Tool Frame -
D: o ~

Geometry

Description

UF and TF will be active automatically after setting. In case, if the user needs to switch
different UF/TF the same is possible in Jog screen.

* ID: Users can set “9” sets (1~9), where default ID 0 cannot be changed
«  Type:

a. Orthogonal / Non-Orthogonal

b. Inclined / Non-Inclined
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2.10.1 User Frame (UF)

The user frame is user-defined coordinate system. User frame are 3-dimensional Cartesian
coordinates defined for each operation space of work piece. The origin can be defined
anywhere in the workspace. Normally work piece or workbench defined as user frame for
ease of jogging and all point information saved based on user-frame origin reference

User Frame: Three points determination

B Description of the setting:

UF/TF Setting v

&% User Frame

y
D: 1o Pl

Type: Orthogonal ~ Non-Incined.Z ~ ' ./—
Input Data ) - P2 : XY (+Y aXlS)
X(mm) Y (mm) _ Z(mm PO : Original

) e
Original | 279.321 | 170.543 | 0.000
+Xaxis | 338.9 45.721 0.000 Pl . +X aXiS
XY 45.721 | -54.823

eIl

Description

1. Setthe ID and Type of the UF (orthogonal/non-Inclined )

2. Feed in details of PO (Original), P1 (+X), P2 (XY) points

*  Method 1: Directly enter information of PO (Original), P1 (+X), P2 (XY) coordinates
*  Method 2: Teaching method

Use Jog and select Cartesian mode. Click [Teach] to teach three points.

3. Click “Set” to save the settings.
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2.10.2 Tool Frame (TF)

A tool-mounting surface at the end of the robot is flange. Three-dimensional cartesian
coordinates whose origin is at the center of the flange named TFO. User shall define the new
TF data whose origin will be the end of the new tool mounted on the flange. Based on the
tool dimensions offset distance components (width & height) and axis rotation angles is
defined for the new tool frame.

&% Tool frame

o N1 - C - |

L | | o I Wdth  Heght  Ange
L ¢ \ = . psd

Geometry . J 3 try 392

ng
(mm) _ (degree)

Rol prch  Yaw
Width  Heght (degree)  (degree) _(degree)
(mm)  (mm) rentation [ o 0

Wdth  Heght
(mm) (mm)  (dedige!
0 0 0

(degree)  (degree) (degree;

0

Rl PRch  Yaw
ree) (degr 2
Orientation 3

Teach

Set

A
: Lokosal

B Description of the setting:
Description:

1. Use Jog and move Robot to Home.

2. Setthe ID of the TF.

3. Define new tool: Click on the blank area of Geometry - Click on the endpoint of the
tool.

4. Set Orientation:

*  Method 1: Direct Input Method (Rotation Set). Direct input Pitch/Roll/Yaw of the tool.

*  Method 2: Teaching method (Open Calibration)

(3.1) Click Teach in the TF.

(3.2) Teaching three points: Use JOG and select Mode Cartesian, with User Frame ID as 0
(UF: 0). Move the end point of the tool to a certain position. Select Origin (Original) /
Extend the X point in direction of the positive X-axis (+X-axis) / Extend the Y-point in
direction of the positive Y-axis (+Y-axis), any of the rows. Click on the Teach button to
record the current position in the table.
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5. Click [Calculate].
6. Click [Set] to save the settings.

= Q DRVO0OL7A6213N-18(VRC1)
= G g7 Base
) Q n
3] Q J2
+ Q i3
= ] e
- 5
* Q J6

) WorkSpaces

o) Gni r
+ Welding Torch
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2.11 Work Space

Workspace supports in defining the working area and restricted area in the robot within the
reach. Application where a user need to limit robot working and restricted area to monitor the
robot movement to avoid peripheral equipment interference needs workspace definition.

User can define nine sets of workspace by entering the position and its related parameters.

m  Operation:

4

=

Soace Type: CYUMNDER El B
Work Type: WORKING
Cyinder Data: [Cyinder Data) | - Py (23 Radus Height
Rectangie Data: [Rectangle Data] + 132300 000 26 L %0
Teach
Color: -
| B -

Yo

B =1

p
[ - e e A ad o SN

) Catalog Browser | Jog

Description
1. Click Virtual Robot - Setting (Work Space)
2. Set Work Space parameters.
* ID: There are nine sets of Work Space available
+  Enable — Activate/Deactivate this work area.
»  Space Type: Workspace shape
a. Rectangle
b. Cylinder
*  Work Type:
a. Working: Area where the robot can operate
b. Restricted: Area where the robot movement is limited.

*  Cylinder Data: Parameters to set the Cylinder workspace

a. Click on the drop down arrow

b. Jog the robot to the required position on the workspace to teach the center point of
the cylinder workspace

c. Right-click and select teach to set the current robot position as center point of

Cylinder Px, Py, and P-.
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o > w

Radius: Enter the radius of the cylinder (mm)
Height: Enter the height of the cylinder (mm)

Cylinder Data:

Rectangle Data:

Color:

[Cyinder Data] |§d
Px Py Pz Radius | Height

vi282.0 0 %6.. 0 0

Rectangle Data: Setting of rectangular range, with the three points of PO, P1, and P2 to
determine the rectangular range.

Color: Set color

Use Jog option to move the Robot > Right-click to select Teach for teaching points.
Check Enable - Enable the list of work areas to be effective
Click Active -Open the Work Space function for the enable work areas

Alarm removal

A warning occurs when the robot moves beyond the defined work Space. User needs to de-
active the Work Space function and then reset the Alarm to continue.

Rectangle Data:

Color:

[Rectangle Data]

[—
Px Py Pz
P 3072 108107  -13.3%
) 28835 108107  -13.3%
2 [ o835 170720 -60.089

Teach

PO

P1
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m  Operation:

SRR -tae

Shotbad  Path VT
Sproying Genwration Setting

00 omman

[ Cotalog Browser Jog

Untsmmdeg QRA -0 W - W& O LR oAy

1.

2. Press Alarm Reset to remove the alarm.

60

Description
When the Alarm appears, first click De-active to close the Work Space function.
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2.12 Collision Detection

Collision detection is a function to check whether robots or other moving parts collide with
peripheral equipment during simulation .A collision set contains two groups, Objects A and
Objects B, in which user picks the objects to monitor collisions between selected groups .
When any part in Objects A collides with parts in Objects B, collision displayed in graphical
view, which will support the user to optimize the Layout.

User to define collision detection with the robot and its tool in one group and rest all parts in
a different group to monitor collision detection.
Operation: Click on Robot - Setting (Collision Detection)

Function Description

Checked: Activate collision detection

Lo Ll LEEEET Unchecked: Deactivate collision detection

If checked - When using TriBall to move a robot, the
Stop Drag at Collision robot movement will be restricted when a collision takes
place.

When the collision takes place, the color of the collided

Display Collision Highlight object highlighted in red.

An audible beep sound will generated when a collision

Enable Sound on Collision
takes place.

Contact is Collision Contact treated as collision.

Warning on the safety distance for collision detection.
Detection object is less than safety distance (Safety
Buffer value), the appearance of the detection object
highlighted in Yellow.

Warning within safety buffer

Selected Components List the objects active in collision detection
Operating mode: List to add assembly as one unit ( No collision detection
Selection Mode between objects under one assembly )

Operating mode:

Drag Mode Start collision detection
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W Operation:

Use Collision Detection
“oflision Detection Options

‘Stop Drag at Collision

[ Display Collision Highligh

[ Enable Sound on Collision

T Componen
All Valid Comy

Components
@ Selected Components

AR -0 e k3 [a

Selection Mode
B Scene €% Search | ) Properties
Properties ~ o x NS )
v X 4

Dragging Behavior | Relaxation ~|
Use Collision Detection
“ Collision Detection Options.
[ stop Drag at Collision
[ Display Collision Highligh
Enable Sound on Collision
2 Contact Is Collision
[ Warning within safety buffer

Check Pairs: Al Pairs. ~|

+ Components for Collision
All Valid Components

@ Selected Components

DRV9OL7A6213N-685(

Y: -102.326, Z: 182.836

MRY: -3.067, RZ: 0

[ Drag tode ]

Description

1. Import Robot, open Jog window and RL editor & Click Virtual Robot-> Collision
Detection

2. Check Selected Components - Selection Mode - Feature to add objects for
collision detection (Possible to add multiple objects as Assembly).

3. Set the method of object selection to Assembly/Part
(3.1) Click Robot in the simulation window - Check [Add assembly as one unit]>Add
(3.2) Select multiple object in simulation screen and add - Check [Add assembly

4. One unit] > Add

5. In Mechanism ->Dragging Behavior, select Relaxation - set other collision detection
parameters (as per description of parameter settings).

6. Switch to Drag Mode.
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7. Move the robot for collision testing.
(6.1) Click on the end of the Tool and use TriBall to drag the robot directly.
(6.2) Use Jog to move the robot (Disable TriBall)
(6.3) Use RL to control the robot (Disable TriBall)

Note:
1. Switch the simulation screen to Shaded. The screen update will be smoother.

Wire Frame

Wire Frame

Wire Frame

e ds A - -9P - 4 -F -l S- =

2. The robot position obtained by dragging the TriBall drag Mode cannot be used for teach
and save

3. Clickon ¥ or 7 inthe collision detection window to stop collision detection.
v Stop collision detection and maintain the current position of all objects

X Stop collision detection and restore the position of all objects
4. Closing the collision detection window is equivalent to turning OFF simulation of the
collision detection.
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2.13 Common

2.13.1 Output (Display Cycle Time)

Output window will display the time taken for the robot for execution. If break point used in
RL editor then the time taken to reach the breakpoint pointer shall be displayed.
Total time taken for the RL execution displayed at end of the every cycle.

VoM x: 326.844, Y: -237.833, Z: 180.801
R e TSl RX: -179.684, RY: 0.019, RZ: 26.972
|obat Cocrdinate System

bie
VSOL7AG213N-1BVRCT)

V90LTASZ1 SH-683 Coel Tumm
V50170571 34683 Coel Tumm
V01T A5 21 M-85 Con o T

etaecnicom View size: 750x 438

2.13.2 Create Object (User-defined Object)
Users can design customized parts/assemblies and set user defined object type like

Feeder, Gripper, link devices and Work piece etc. and import within simulation

environment.

B Operation: Create a component - Select the component - Virtual Robot-> Create
Object

& cene | & Seavch 8] propenies

10 Moriter X Oupst
O mput [[DRYS0L7AG21 0685 Conie Tame] Liw 11, So: 1 984 o EEE—
V30U TAG21 0685 CoeleTameq Lo 14, Soc: 4068 Shapes DeRaRober DemoSample | Took | =

< VI0LTAG21 685 CockeTume] Tobl,, S 6032
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B Description of the settings:

Snpes Detafobot DemoSample Took %

Description

Select component > Click Create Object

Change component name (Element ID cannot be changed).

Set the component type (Type: None, Feeder, Gripper, and Work piece).

Click Set to save the settings.

Drag the set component to the Catalog.

Click Save to save the Catalog.

Note:

1. Feeder needs to be assembly, not as a part

2. The work piece parameters of feeder is set in Virtual Robot > Properties - File Name
(Refer Feeder in Section 2.9.4)

3. Work piece can be added from Catalog browser , but default type of the new work piece
when pulled to the simulation screen is none, so user need to set the type as Work piece
with create object function.

o g~ wDdpRE

~ CresteObject = & x Cotalog Browser - % =

[ Hew [ Open |G Save [ Chowx
Wame  newPart 4| Search K
e S R—

AT R S
i
[Fendar ‘WorkPiece ShoePad  WorkPiece
Grigper
' - ~
Feeder  Senor Conveyor
Table Table Operator
h-—'\-—-_ ScrewingT... ScrewingTig T ontrolBox
| 1
e -

] I I

-8 x

Shapes DeltsRobot | DemoSample | Took =
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4. Work piece generation by Feeder —~Work Piece anchor point to be maintained at global
coordinate origin. Work piece will generate at feeder frame position added with offset
distance from the global origin.

B Example: Create Gripper

*  Operation: Use the component library shapes to create Gripper (Refer Shapes Section
2.1.1) or import the Gripper Step file (Refer Gripper Import Section 2.9.3). > Create the
EndP joint point (Refer Attachment Point Section 2.2.6), and verify whether the Z axis
coordinate of the joint point is oriented correctly - Click on Create Object > Set
component type: Gripper

~  CreateObject - 3 x
Name Portl
Type Gripper
Hame
Name of the Object
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2.13.3 Low Quality Render

Optimizes screen performance and simulation speed. If user works with CAD models of
bigger size recommended to choose Low Quality Render to evaluate the cycle time, which
shall automatically optimize the screen and the simulation performance.

B Operation: Virtual Robot - Low Quality Render

= Output

CreateObject
LowQualityRender|

Common
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2.14Import/Export CAD files

Import/export files of equipment, geometries, reducer, jig, Work piece, robots, tools and

standard libraries etc.

m  Instructions for importing files: Click the toolbar Assembly - Import - Select the file
- OPEN

Assembly Tree Exporter

59 Export Part

Op.

[ @ impon File =
WBTED: [ DRASomuCAD -] ©® F i m@m-
* é"o?iDOneRobc( 1ics / ZSDE!:QE ?30 TS 04:55 i
L BT DT ..
N 07300neRobot_3.ics 2019/7/31 £ 08:55
— e
W 0801.ics 2019/8/1 T 02:04
— 0801 demoics 2019/8/1 F= 0242
B2 L W 0801_demo_O.ics 2019/8/1 ‘\f o7 13
= B Zororee £ 1007
2019/7/10 £ I1:0)9 v 3
B Broview Search
Import Options
m  File format supported for import
File format File extensions File format File extensions
ACIS Part *.sat VRML *wrl
Parasolid Part *x_t; *.xont_txt SketchUp *.skp
STEP AP203/214 *.stp; *.step HOOPS OOC *.00C
Romulus * xmt Point Cloud *.pts; *.ptx; *.xyz
IGES *.igs; *.iges Pro/E Part *.prt
IronCAD Part *.ics; *.ic3d Pro/E Assembly *.asm
TriModel *tmd CATIA V4 *.model
3D Studio *.prj; *.3ds CATIA V5 *.CatPart; *.CatProduct; *.cgr
trueSpace *.scn; *.cob 4UG *prt
AutoCAD 3D DXF *.dxf Solid Works * sldprt; *.sldasm; *.prt; *.asm
AutoCAD 2D File .dxf; *.dwg Inventor *.ipt; *.iam
Wavefront *.obj JT *jt
Raw *.raw Solid Edge *.par; *.asm; *.psm
Stereolithography *.stl; *.sla
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B Instructions for exporting files: Click on the object - Click on the toolbar Assembly >

Export Part-> Save

2 [

Operations

Bl Assembly Tree Exporter

&5 Positioning Constraints
Wy O3 Mate & Align Positioning

niBall
TaBall o Fiediin Parent

REER

=5

@ =xportFile

e |

DRASumCAD 2018 ]

=%
logs

S ¥ i° @~
L 3=t i
2019/7/30 £ 11:37 1

mxEWe): [Pl

TR STEP AP214 (*stp,* step)

B File format supported to export

File format File extensio File format File extensions
ACIS R26 *.sat Parasolid 29.0 *X_t
ACIS R24 *.sat Parasolid 26.1 *x_t
ACIS R23 *.sat Parasolid 25.1 *x_0
ACIS R21 *.sat Parasolid 24.0 *x_t
ACIS R19 *.sat Parasolid 22.1 *X_t
ACIS R18 *.sat Parasolid 21.0 *x_t
ACIS R17 *.sat Parasolid 19.1 *Xx_t
ACIS R16 *.sat Parasolid 19.0 *x_t
ACIS 7.0 Part *.sat Parasolid 17.1 *X_t
STEP AP203 *.stp; *.step Parasolid 16.0 *X_t
STEP AP214 *.Stp; *.step Parasolid 11.0 *Xx_t
IGES *.igs; *.iges 3D PDF File *.pdf
CATIA V4 *.model Hoops Stream File *.hsf
CATIA V5 Part *.CatPart IronCAD Mobile File *icsw
CATIA V5 Assembly *.CatProduct
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3. Application APP

3.1 Path Generation

Path Generation helps in generating accurate paths (linear and circular) based on CAD
geometry. Path generation feature can create both linear and circular paths along the
selected edges of a surface. To create a path user need to select the edge using enable
edge selection mode and choose multiple edges and the closest edge of the selection be

picked for inclusion in the path generation.
Operation: Click directly on Virtual Robot > Path Generation

B Scenario setup:

Cartesian
UF: 0
Cartesian Mode

ol <
&l <
—

<

[Z] Catalog... PathGener... UF/TF Setti... Jog | Point

- B x

100 %

® Joint

 Cear—

User

1214388

(|

ER e ¥
>

-1601209

Description

1. The robot returns to Home.
2. Combine the robot with Tool.
3. Set up Robot TF.
4

Drag in the part/component for path generation inside the simulation window
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®  Description of the setting:

=B L 1| o2 ® &
oun
-

shoePad]  Pat

PathGeneration v B ox
Monitor | WorkSpace | Properties - Collision Detection

Robot Type: SCARA

H Salect Type: Continued E... ~
5. Highlight
Robot

nd Type: o o0k -

SCARA

Sngle Edge
Point interval (mm): 10.00

3% offset (mm)
X axis 000
Y axis 0.00

Z axis 0.00

&% Rotation (Deg.)

¥ axis

Z axis 0.00

Generate

PASS modeinRL B Paact -

ert.. UF/TFS... Jog

Description

1.
2.

Import the object and click Virtual Robot-> Path Generation

Set Robot Type, Select Type, and Hand Type. - Click Enable to enable the edge

selection mode > Select edges in order on the part (Clear List: Clear all selected edges

and paths).

*  Robot Type:

SCARA

SCARAS5

VA

Select Type (edge selection mode):

Single Edge: Picks the single edge

Continued Edge: Picks the continuous line connected to the edge.

* Hand Type (hand system):

a. 0: R (right hand)

b. 1:L (left hand)

Set the parameters of the path generated

+ Consistent Rotation: Coordinates of path generated maintains the set value of RZ.
The direction of rotation of RZ defined as Z-axis rotation in degree.

+  Consistent Translation: All paths translated together over a fixed distance.

o Ty

SIS
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Consistent Rotation Consistent Translation

J OffsetX : 10 mm
d/

+ Point interval (mm): Spacing per point

4. Click Generate Points to generate the point and User Frame.

5. Select the Robot.
6. Click Generate Project to generate the project for the robot (including points and RL).

Scene v e x

Search X

W C\Users\michag

-3+ Global Coor

=% DRS40L3SS-7(VRCT,
» R gPBase

& () Teached Points -
= Tondiece

aaaaaa

Note:

1. PASS mod in RL: If checked the RL will be generated with PASS instruction (Refer RL
User manual for details)

2. Project can be exported directly to MS for program execution (Refer Project
Management Section 2.5).
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3. Editing and deletion of a single edge

e Operation:
Click Disable to close the edge selection mode > Click the left button on the single
edge to edit.
Select Edit / Delete> Set the Offset and Rotation of the single edge.

PathGencraticon - == S
—

Vo kP iece - — Ecdoage-
Vo rikPiece - = Edage-
Vo rkPiece - = Ecdage:

Robor Type- ScAaARA ~
Select Type- Contmnmued E. .. —
Harnd Type- o - =) —

Gemnaerate

it Tlear List

Ernaible
Comnsistent Rotaticon
Comsistent Tramnslaticon

Poinmt imntecrval Gmrm) s S 00

e PR T T icrTs CED>e<3_ D
< i [ooco q
=

—_—

4. Setting UF origin
Generate Points will automatically generate the path coordinates of the selected edge
and the default User Frame will also be generated at the same time. Choose User Frame
and activate TriBall to move the UF origin.

Scenel* X
Scene v X

Search .. X'
¥ Scenet
- J» Global Coordinate System
5§ DRS40L3SS-S(VRC1)
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5. Edit/ Delete Point

Upon successful generation of the project user can access the coordinate points under
the Scene tree/Robot/Teach points. User can selected individual points, check the

reference simultaneously in the simulation window and edit / delete the points as per the
application.

Scenet” x

Scenel® x

Scene v ix
Search x ':'..
¥ Scenet a

Scene
Search
N Scenel
& Ja Global Coordinate System
'§) DRSA0LISS-S(VRCT)
ol vioidiece

@ J+ Global Coordinate System
& '§) DRS40L3SS-5(VRC)
5 @ Vo

1
3 Coord12

= PO
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3.2 Shoe Pad Spraying

Shoe Pad Spraying App supports in generating accurate paths (linear and circular) based on
edges selected in the Shoe Pad CAD  geometry. Shoe Pad Spraying will have additional
features of spray distance and inward offset which are relevant to Shoe Pad application.

®  Operation: Click Virtual Robot - Shoe Pad Spraying

W Scenario setup:

A &% Distance

 Cartesan Jont
UF: 0 o LLCREY -
~ Cartesan Mode User
o
x
L << S & |
< >

[E:} Catalog Browser ShoePad Spraying | Jog | Point

Description

(1) Robot returns to Home.

(2) Combine the robot with Tool.
(3) Set up Robot TF.

L2 Em = & 1 o} ShoePad Spraying v 3 x
5 aus[e : S

Spraying peneration E o
UFITF | Monitor WokSpace Properties  Collsion Detectio e Comamon Ucense Manager e

Generate Cle:
o] =
&% Setting 3

ShoePad->Edge:13
ShoePad->Edge:14

Spray Dist (mm) 10.00
Point interval(mm). 10.00
Inward Offset(mm): 0

3% Offset (mm)

X axis 0.00

Y axis 0.00

Z axis 0.00
&% Rotation (Deg.)
X o

¥ axis 00.00

Z axis 000

6 Generate
& Rotation (Deg.) PASS mode in RL -

[ Catalog Be...| ShoePad Spes... Jog Point [} Catalog Br... | ShoePad Spra. oint

(4) Drag in the part/component for path generation inside the simulation window
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®  Descriptions of the setting:

Description:
1. To import objects, click Virtual Robot=> Shoe Pad Spraying
2. Set Robot Type, Select Type, and Hand Type. - Click Enable to enable the edge
selection mode > Select edges in order on the part (Clear List: Clear all selected edges
and paths).
3. Set the parameters for the path generation
e Spray Dist. (mm): The distance from the point along the Tool Z axis to the spray
side
* Point Interval (mm): Pitch between the point along the Tool Y axis and the
subsequent point
* Inward Offset (mm): The offset distance of the point from the spray side along the
Tool X axis
Tool X axis :
Inward Offset .
/ Tool Z axis : Spray Dist.
1. Click Generate Points.
2. Click on Robot.
3. Click Generate Project to generate the project for this robot (including points and RL).
Note:
1. PASS mod in RL: If checked the RL will be generated with PASS instruction (Refer RL
User Manual)
2.

Project can be exported directly to MS for program execution (Refer Project
Management Section 2.5)
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3.3 Conveyor Tracking — CVT

Conveyor tracking, robot Tool Frame (TF) will automatically follow a User Frame defined on
the moving conveyor. While tracking the conveyor the robot will maintain the programmed
TF speed relative to the user frame even if the conveyor runs at different speeds.
Architecture of Conveyor Tracking — Refer below Picture (Refer Delta Conveyor tracking
User manual)

+ SCARA x1

« Conveyer x 1 . Vision x 1 + DCS controller x 1

DMV SCARA

« Encoder x1
Conveyer direction Encoder
— / W
| / \ﬂﬂ

B Simulation Scenario setup:

Gioper Come Fande Samian| O

<X Do G
e e Y N YT - S S S
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{8

Llmport conveyor

1.DemoSample

SR ATERINE N

®  Description of the setting:

Description

Import robot from Catalog Browser Virtual Robot - Delta Robot >DRS/VA

Attach gripper from Catalog Browser Virtual Robot = Tools Catalog > Gripper
Define TF data (Refer Tool Frame Section 2.10.2)

Import conveyor from Catalog Browse Virtual Robot > Demo Sample ->Conveyor
Set conveyor parameter (Refer Conveyor Section 2.9.5 )Virtual Robot > Properties
Import Feeder from Catalog Browse Virtual Robot-> Demo Sample->Feeder

Set Feeder parameter (Refer Feeder Section 2.9.4 ) Virtual Robot> Properties

Import sensor from Catalog Browse Virtual Robot > Demo Sample-> Sensor

© ® N o g p 0 N -

Set sensor parameter (Refer Sensor Section 2.9.6 ) Virtual Robot-> Properties

=
o

. Configure Sensor DI/DO and sensor DI/DO ) Virtual Robot - Properties

[E=Y
[y

. Enter CVT Setting Virtual Robot > CVT Setting
i. In select model /Robot — Click select and highlight the robot in simulation window

ii. In select model /Conveyor — Click select and highlight the conveyor in simulation
window

ii. In select model /Sensor — Click select and highlight the sensor in simulation window

iv. Upon confirmation that the robot model , conveyor and sensor name appears in the
select model click “Set”
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9 @ & UFTF Setting S setup. ﬁ‘ L
| i 1o s CHEK CVT
Setting

Selete Robot
Selete Conveyor

Selete Sensor

=] acager
3 paniamed

3 ratiramer

e faid o
@
0

Y

3

® il

)

s

i+ 3

i 3

I B -

& Scene [ @ search B Properies

VO vondr v % % DO Gippe Cone. Feeder Semor. | VT

[rrT——— Vewsic0sx @4 Untsmmoey Q& @ B -t & TS BRI b s - ot ~/db

1. Position setting

i Click Start line , End Line and Sensor line

ii. User can identify that a rectangular box indicating sensor line , start line and
sensor line will be appearing in the simulation window

IECN

Sconat
i &+ Global Coordnate Sysiem
605

&9 DRS¢
» B

Moving
Sensor oot e scaRA
N Line o s —
9% Moving
3 End Line
: § | Moving
fE 3 Start Line
wd 4
'8 J %
& Scene | @ Semvch W Properies.
1O Mondor 3 % [ Gigper Conve.. Feeder.. Sensor..| VT
it fwe dtaus com Viewsize 10863 624 Unitsrm deg R @ - - W - - & 05 O DI & oA R S

iii. Under scene browser — User can identify the CVT Conveyor line added

iv. Expand CVT conveyor and using TriBall locate the start line , end line and sensor
line on the simulation window

V. Ideally start line and End line should be within the robot reach and sensor line to
be located at the sensor intersection point with the conveyor direction
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2. Project Setting
i. Select robot type SCARA / VA as per the application

i. Key in the project Name

ii. Highlight the robot and create the project

ne

nnnnn

satine  Endlne

Select Robot Type

Key in project name

Creat project

Come.
=)=

-
Ve W 2t U ey @ @ -6+ -4y - f b9 7 @ b

Open Project Manager and edit the project

Set the UF and TF data ( Refer Tool Frame Section 2.10.2)

Teach point “P0” Standby point

Teach point “P1” UF point for tracking

Optimize trans_ccd_x & trans_ccd_y values such that the Robot tracks the work piece

N oo g > w

on the moving conveyor

8. Execute the project

Note:
a. Conveyor, feeder and sensor position needs optimization suiting the application

requirement.

b. Its recommended to check the conveyor feeder and sensor function individually before
doing CVT setting

c. Conveyor speed and feeder speed to be optimized for the tracking time and distance, if
not robot will drop the user frame if the connected user frame goes beyond the end line.

d. Monitor window for IO updates to be opened simultaneously to ensure the cross
connection of input with sensor and output trigger

e. PASS mod in RL: If checked the RL will be generated with PASS instruction (Refer RL

User Manual )
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4. Example of application scenario setup

4.1 One Robot Pick and Place

B Reference- Tutorial video "Tutorial1_OneRobotPickAndPlace".
B Scenario setup: Once the sensor detects the feeder-generated object, the robot starts

to pick up and place the objects.

[

Description

1. Switch to screen-viewing angle TFR.

2. Import the table and riser into the simulation screen (Riser used to elevate the robot).

3. Attach the robot with the tool-> UF/TF to set Robot TF.

4. Click on Robot = Project Manager to add a project.

5. Make sure the TF change is successful: Jog = Switch TF ID - Jog the Robot - Teach
point.( Cross check the TF data )

6. Set Robot Properties = Robot 10.

7. Input: Sensor

o1 A AELTA
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«  Output: Gripper

[ \j-ii"\!ﬂf—]l?ﬁ 1) propemes: “:“’E“ 1.-5-;|:Jcer-nm.|-wcew=@
e [ ][ ome
1. Setup Feeder
1.1 Properties
Properties v o X
v Feeder 10
Input (Collection)
v Feeder Setting
FileName C:\Users\I-Erin.Chang\D
Speed 30
Number -1
Mode Normal

1.2 Turn ON simulation button > Generate a work piece - Turn off simulation switch.

1.3 Hide the Feeder - Delete the work piece other than the source work piece,
leaving the source work piece - Change the Anchor of the source work piece.

1.4 Display the Feeder - Adjust the Feeder Frame to the target position where the
work piece to be generated.

1.5 Turn ON simulation button > Generate a hew work piece and confirm that the
anchor position changed successfully > close the simulation button.

2. Set the number of the Feeder Properties to zero (stop generating work piece).

3. Select Robot - Jog to the grip position > Teach point = Jog to the placement position
- Teach point.

4. The number of Feeder Properties is set to -1 (infinite number of work pieces generated)
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5. Open RL editor and edit RL

6. Turn ON the simulation execute the RL to run the simulation.

Note:

Work Piece and Gripper anchor:
The distance between the anchor position of the gripper and work piece to be ensured within
the range of the gripper setting distance.

*  Method 1: Adjust anchor position of the work piece

%D“mw @

FeederFrame FeederFrame

*  Method 2: Adjust anchor of the End Point of the tool
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4.2 Multi Robot Demo

Reference-Tutorial video "Tutorial2_MultiRobot".

Scenario setup: Continuation of the scenario in chapter 4.1 of object pickup and place

with six-axis robots added additionally. Complete IO communication between two

arms, and combine Conveyor for moving objects.

Open "Object Pickup and Placement Scenario" (section 4.1).

Change the Mode of the Feeder to DI Trigger Controlled > With control by SCARA
Output 3, generate a new work piece - Change and confirm that the anchor of the

source work piece is within the range of gripper Tool.

? X

SHE

v 110
Input 1

v 2.From Device
Name DRS40L3SS-20(VR(
Output 3

v Feeder 10 Properties
Input (Collection)
v Feeder Setting
FileName C:\Users\I-Erin.Chang\
Speed 30
Number =3
Mode DI trigger
1/0 Monitor
5 Output
: 2 =) ’

Description
1.
2.
InputLinkModel Collection Editor
«y +
+
Add Remove
3.

Import the old SCARA project = Grip the work piece = Jog to move it to the placement

A AELTA
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4. Drag and drop six-axis VA robot from the catalog.

(4.1) Attach the tool on a six-axis robot.

(4.2) Setting up a six-axis Robot TF.

(4.3) Adding a six-axis robot project.

(4.4) Teach test point to confirm that the TF setting is successful.

5. Drag conveyor from the catalog to adjust position and size.
6. Set Gripper Properties = Gripper IO.

* Input: Six-axis Robot

InputLinkMadel Collection Editor ? x
Members:
«-DREYI0LTAG21 3N =
I} 1--DEVIOLTLAZ]1SN E="E~Ir|_|
v 1.10
Input 1
v 2.From Device
Name DRVIOL7A6213N-5
Qutput 1
7. Set Robot Properties > Robot 10
* Input: SCARA
*  Output: (1) Gripper, (2) SCARA
InputLinkModel Collection Editor Input OutputLinkModel Collection Editor Output
Members: Members:
| & 2l 0] 1->Gripper-5655(1) + Bhl4 |
. Y 2->DRS4 0@2) —
v 110 + v 110
Input 2 Output 2
v 2.From Device Vv 2.To Device
Name DRS40L3SS-20(VR( Name DRS40L3SS-20(VR(
Output 2 | | Input 2
Members: 1->Gripper-5655(1) properties:
Add Remove Output 1
v 2.To Device
o i
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8. Set Conveyor Properties

(8.1) Properties

Properties

v Conveyor 10
Input

v Conveyor Setting
Speed
Behavior
Mode

v Frame

Path Frame

(Collection)

0.05
Stop
Normal

o
®
7

X

Add Frame Button

(8.2) Click Add Frame -> Add PathFrameO (starting position) and PathFramel (end
position) > Use TriBall to move PathFrameO and PathFramel positions.

9. Select the six-axis Robot - Grip the work piece = Jog to the gripping position - Teach
Point of placement position-> Jog to the placement position > Place the work piece and
ensure that the part will be moved by the conveyor > Teach Place point.

Note: The work piece anchor needed to overlap with the conveyor plane, so that the

work piece can move once the conveyor switched ON.

10. User to edit RL.

11. Turn ON the simulation button and execute the RL to run the simulation.
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5. Frequently Asked Questions - User FAQ

1. How to check the DRASImuCAD version insta
2. Click Menu-> Help-> About.

lled?

A=

=

L E N

Delta

Help

.| @
- Help
&

SimuCAD

Partial Copyright [c]1995
Partial Copyright (c]2016

IRONCAD. INOVATE. IRONCAD DRAFT, sBehavior, &C

Product Hame: DRASImUCAD

Version: 0.40.05.00 I

Date: 20130617

Licensed Ta:

64Bit Version Build Number: 15558
Suppart:
Tel 886-4-25677670

Emait It 277

Web Site: wywy, deltavs. com

Copyright 2018 Delta Electronics. Inc. All ights reserved

- 2018 onCAD. LLC All rights reserved.
- 2018 CAXA Technology, Co., Ltdl

TeamVaul.

Eloptions... X Exit

License Agreement

5

InteliShape, TriBall, SmartMotion, lronT ool, Design Flow, Direct Face

ontent, eMarkup.
1D

How to change the language of the User Interface?

Click Menu—>Options - Language. After changing the settings, close and reopen

DRASIimuCAD.

P

[ @ o Topics
= Help Tutorials

Options - Language

Options

Assembly

@ Interaction

Directories

Sheet Metal

Rendering
Performance

|- AutoCAD Import
Properties List

Default Property Setting
Color

enearal
Parts

Display Language
[English(United States)

L

* Take effect in new session

What will be stored in the project archive?

C:\Delta Industrial Automation\DRASIimuCAD\bin\VRC\VRC1\lua = RL project, point

data

C:\Delta Industrial Automation\DRASIimuCAD\bin\VRC\ VRC1\VRC Parameter = UF,

TF, Workspace
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5. Where is the folder location to execute the MS controller project backup of the MS in
DRASIimuCAD?
C:\Delta Industrial Automation\DRASIimuCAD\bin\VRC\VRC1\lua
See section 2.4 for details.

6. How many virtual Robot can be imported and used to make simulations in the current
version?
Maximum of Twenty Virtual robots, however, the performance based on the PC
configuration with independent graphic card, CPU i7, and RAM 16g to support an
operation with 20 virtual robots.
How do we increase the number of virtual robots by user?
Copy paste and re-name the VRC20 folder under the below path (C:\Delta Industrial
Automation\DRASIimuCAD\bin\VRC folder) and re name it to VRC21.

T » FEEE (C) » DeltaIndustrial Automation > DRASImuCAD » bin » VRC

7. What is the location for TF and UF parameter files?
C:\Delta Industrial Automation\DRASIimuCAD\bin\VRC\VRC1\VRC Parameter

8. How much length can the project name be?
“26” English characters maximum

9. How to create a new tool?
Refer Gripper Section 2.9.3 and Tool Frame Section 2.10.2

10.Draw a tool (Refer Shapes Section 2.1.1) - Create an attachment point (Refer
Attachment Point Section 2.2.6) > [Create Object] (Refer Gripper Section 2.9.3) >
Component Type: Gripper.

11.How to create a user defined object?
Draw objects (Refer Gripper Section 2.9.3) = [Create Object] (Refer User defined
Object Section 2.13.2) - Component Type: Work piece.

12.How to reorient the robot on the window? How to pan? How to drag to the desired
position?
Refer TriBall Section 2.2.2
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13.Jog operation is not working. How to trouble shoot?
Click on the arm. JOG parameter setting, such as Speed. Check for the presence of
any alarm, need to reset before Jog operation.

14.What should we do when the table becomes a sub-item for the Robot?
Recommended to delete the table and add it again. User needs to take care that while
adding a new part robot is not highlighted or selected. In case the robot is highlighted
/selected then the new part created will become sub-item of parent robot.

15.How is User 10 set? How to handshake with another |10?
Refer 10 Connection Setting Section 2.9.1 Properties Settings and Refer Multi Robot
Demo Section 4.2

16.What should the user do if the simulator button turns gray/dull?
Restart DRASIimuCAD, since the problem is with connecting virtual robot VRC

17.What should user do if the RL program is not executing after clicking start?
Check if the simulator is in ON condition and system has no alarm. If still not responding
after few seconds, restart DRASimuCAD.

18.What should user do if the simulation motion is slow with multiple robots running at the
same time?
Click Virtual Robot - Low Quality Render (Refer Low Quality Render Section 2.13.3).

19.What should user do if there is license error upon launching DRASimuCAD?
Click Virtual Robot - License Manager - Check whether the license has expired. If so,
please contact Delta Electronics, Inc.

License Manager x

Customer ID

s ““""be':_ Bt

Input License

%

License
Manager

Key: Outcome: Verify

License Manager License Status

Software Register Date Remaining Times Expiration Date
01 10 it

» PathGenerationApp 201

ShoePadSprayingApp

2019/09/30

2019/09/30

Simulator 2019/07/10 Unlimited 201

20.How to set up multiple tables on the same plane? How to align them?
Refer TriBall Section 2.2.2 illustration to align multiple tables.
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21.How to command GO HOME?
In jog window, choose Cartesian jog mode and Click ( L Home) button

22.What should user do when the “lua server” is disconnected?
Method 1: Delete the current robot and add new robot again from the catalog.
Method 2: Do not delete the robot, close and restart DRASimuCAD.
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